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ASG Support Numbers
ASG provides support throughout the world to resolve questions or problems regarding 
installation, operation, or use of our products. We provide all levels of support during normal 
business hours and emergency support during non-business hours. To expedite response time, 
please follow these procedures.

Please have this information ready: 

• Product name, version number, and release number 

• List of any fixes currently applied 

• Any alphanumeric error codes or messages written precisely or displayed 

• A description of the specific steps that immediately preceded the problem 

• The severity code (ASG Support uses an escalated severity system to prioritize service to 
our clients. The severity codes and their meanings are listed below.) 

• Verify whether you received an ASG Service Pack for this product. It may include 
information to help you resolve questions regarding installation of this ASG product. The 
Service Pack instructions are in a text file on the distribution media included with the 
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem. 

2 Leave a detailed message including your name and phone number. A Support representative 
will be paged and will return your call as soon as possible. 

3 Please have the information described above ready for when you are contacted by the Support 
representative. 

Severity Codes and Expected Support Response Times

ASG provides software products that run in a number of third-party vendor environments. Support 
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor 
discontinues support for a hardware and/or software product, ASG cannot be held responsible for 
problems arising from the use of that unsupported version.

Severity Meaning Expected Support Response 
Time 

1 Production down, 
critical situation

Within 30 minutes

2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has 
work-around solution

Within 4 hours

4 "How-to" questions and enhancement 
requests

Within 4 hours



Business Hours Support 

Non-Business Hours - Emergency Support 

Your Location Phone Fax E-mail

United States and 
Canada

800.354.3578 941.263.2883 support@asg.com

Australia 61.2.9460.0411 61.2.9460.0280 support.au@asg.com

England 44.1727.736305 44.1727.812018 support.uk@asg.com

France 33.141.028590 33.141.028589 support.fr@asg.com

Germany 49.89.45716.222 49.89.45716.400 support.de@asg.com

Singapore 65.332.2922 65.337.7228 support.sg@asg.com

All other countries: 1.941.435.2200 support@asg.com

Your Location Phone Your Location Phone

United States and 
Canada

800.354.3578

Asia 65.332.2922 Japan/Telecom 0041.800.9932.5536

Australia 0011.800.9932.5536 Netherlands 00.800.3354.3578

Denmark 00.800.9932.5536 New Zealand 00.800.9932.5536

France 00.800.3354.3578 Singapore 001.800.3354.3578

Germany 00.800.3354.3578 South Korea 001.800.9932.5536

Hong Kong 001.800.9932.5536 Sweden/Telia 009.800.9932.5536

Ireland 00.800.9932.5536 Switzerland 00.800.9932.5536

Israel/Bezeq 014.800.9932.5536 Thailand 001.800.9932.5536

Japan/IDC 0061.800.9932.5536 United Kingdom 00.800.3354.3578

All other countries 1.941.435.2200



ASG Web Site
Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at 
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941) 
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG 
product you are using. For documentation suggestions include the publication number located on 
the publication’s front cover.

http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface
This ASG-Estimate Installation Guide provides information about the installation and 
maintenance of ASG-Estimate (herein called Estimate). Estimate is a tool for estimating 
the cost of code conversion projects that span your business Enterprise. Use Estimate to 
define your organization and business applications, develop and apply change criteria, 
and produce an estimate of resources required for the project.

Estimate creates a database to answer these conversion project questions:

• How many items?

• How big is the overall effort?

• How complex are the tasks? 

This information is then analyzed and managed based on unique site requirements and 
environment.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions 
or concerns regarding the installation or use of any ASG product. Telephone technical 
support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this 
publication or on any ASG product.

About this Publication
This publication consists of these chapters:

• Chapter 1, "Introduction," gives an overview Estimate, its operating system, and the 
systems it supports.

• Chapter 2, "Estimate Customization," discusses some of the customization options 
available in Estimate.
iii
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Related Publications

The documentation library for ASG-Estimate consists of these publications (where nn 
represents the product version number):

• ASG-Application Definition and Analysis User’s Guide (ALL0200-nn) describes 
defining and analyzing an application in ASG-Alliance, ASG-Recap, and 
ASG-Estimate.

• ASG-Center Installation Guide (CNX0300-nn) describes installation and 
customization procedures for ASG-Center. ASG-Center must be installed before 
installing ASG-Estimate.

• ASG-Estimate Installation Guide (TMX0300-nn) provides information about the 
installation and maintenance of ASG-Estimate.

• ASG-Estimate User’s Guide (TMX0200-nn) describes how to use ASG-Estimate to 
measure the complexity, financial, and resource impacts of code conversion 
projects.

Note:
To obtain a specific version of a publication, contact the ASG Service Desk.
iv



Preface
ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist 
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW 
products use the Application Knowledge Repository (AKR) to store source program 
analysis information generated by the Analytical Engine. Figure 1 represents the 
components of ESW. 

Figure 1 • ASG Existing Systems Workbench 

Existing Systems Workbench

ASG-Insight for Program Understanding

ASG-Estimate for Resource Estimation

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
- TSO
- CICS
- IMS
- ASM
- APS
- PLI
- TCA
- DB2 Stored Procedure

ASG-SmartDoc for Program Documentation

ASG-Recap for Portfolio Analysis

ASG-Alliance for Application Understanding

ASG-Center

Application
Knowledge

Repository (AKR)

ASG-Encore

ASG-AutoChange

ASG-Bridge
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ASG-Estimate Installation Guide
This table contains the name and description of each ESW component:

ESW Product Herein Called Description

ASG-Alliance Alliance The application understanding component that is 
used by IT professionals to conduct an analysis of 
every application in their environment. Alliance 
supports the analysis and assessment of the 
impact of change requests upon an entire 
application. Alliance allows the programmer/ 
analyst to accurately perform application analysis 
tasks in a fraction of the time it would take to 
perform these tasks without an automated 
analysis tool. The impact analysis from Alliance 
provides application management with additional 
information for use in determining the resources 
required for application changes.

ASG-AutoChange AutoChange The COBOL code change tool that makes 
conversion teams more productive by enabling 
quick and safe changes to be made to large 
quantities of code. AutoChange is an interactive 
tool that guides the user through the process of 
making source code changes.

ASG-Bridge Bridge The bridging product that enables field expansion 
for program source code, without being required 
to simultaneously expand the fields in files or 
databases. Because programs are converted in 
smaller groups, or on a one-by-one basis, and do 
not require file conversion, testing during the 
conversion process is simpler and more thorough.

ASG-Center Center The common platform for all ESW products. 
Center provides the common Analytical Engine to 
analyze the source program and store this 
information in the AKR. This common platform 
provides a homogeneous environment for all 
ESW products to work synergistically.
vi



Preface
ASG-Encore Encore The program re-engineering component for 
COBOL programs. Encore includes analysis 
facilities and allows you to extract code based on 
the most frequently used re-engineering criteria. 
The code generation facilities allow you to use the 
results of the extract to generate a standalone 
program, a callable module, a complement 
module, and a CICS server. Prior to code 
generation, you can view and modify the 
extracted Logic Segment using the COBOL 
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user 
to define the scope, determine the impact, and 
estimate the cost of code conversion for COBOL, 
Assembler, and PL/I programs. Estimate locates 
selected data items across an application and 
determines how they are used (moves, arithmetic 
operations, and compares). Time and cost factors 
are applied to these counts, generating cost and 
personnel resource estimates.

ASG-Insight Insight The program understanding component for 
COBOL programs. Insight allows programmers 
to expose program structure, identify data flow, 
find program anomalies, and trace logic paths. It 
also has automated procedures to assist in 
debugging program abends, changing a 
computation, and resolving incorrect program 
output values.

ASG-Recap Recap The portfolio analysis component that evaluates 
COBOL applications. Recap reports provide 
function point analysis and metrics information, 
program quality assessments, intra-application 
and inter-application comparisons and 
summaries, and historical reporting of function 
point and metrics information. The portfolio 
analysis information can also be viewed 
interactively or exported to a database, 
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for 
COBOL programs. SmartDoc reports contain 
control and data flow information, an annotated 
source listing, structure charts, program summary 
reports, exception reports for program anomalies, 
and software metrics.

ESW Product Herein Called Description
vii
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Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you 
need assistance to activate a product, see your systems administrator. If your site starts a 
product directly, use the ISPF selection or CLIST as indicated by your systems 
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen 
using the ISPF selection or CLIST as indicated by your systems administrator and then 
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or 
through ESW. See "ESW Product Integration" on page ix for more information about 
using ESW.

ASG-SmartEdit SmartEdit The COBOL editing component that can be 
activated automatically when the ISPF/PDF 
Editor is invoked. SmartEdit provides 
comprehensive searching, inline copybook 
display, and syntax checking. SmartEdit allows 
you to include an additional preprocessor (for 
example, the APS generator) during syntax 
checking. SmartEdit supports all versions of IBM 
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL, 
PL/I, Assembler, and APS programs in the TSO, 
MVS Batch, CICS (including file services), and 
IMS environments. SmartTest features include 
program analysis commands, execution control, 
intelligent breakpoints, test coverage, pseudo 
code with COBOL source update, batch connect, 
disassembled object code support, and full screen 
memory display.

ESW Product Herein Called Description
viii



Preface
To initialize ESW products from the main ESW screen, select the appropriate option on 
the action bar pull-downs or type the product shortcut on the command line.

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW 
products directly or through the main ESW screen. As a result, you might see different 
fields, values, action bar options, and pull-down options on a screen or pop-up depending 
on how you accessed the screen or pop-up. 

Certain ESW products also contain functionality that interfaces with other ESW products. 
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic 
link to Alliance that can be used to display program analysis information. If Insight is 
installed and specified during the analyze, the Insight program analysis functions are 
automatically available for viewing logic/data relationships and execution path. For 
example, the Scratchpad option is available on the Options pull-down if you have Insight 
installed. Access to these integrated products requires only that they be installed and 
executed in the same libraries. 

Product Name Shortcut ESW Pull-down Options

Alliance AL Understand  Application

AutoChange CC Change  Conversion Set

Bridge BR Change  ASG-Bridge

Encore (Re-engineer) EN Re-engineer  Program

Estimate ES Measure  ASG-Estimate

Insight (Understand) IN Understand  Program

Recap (Portfolio Analysis) RC Measure  Portfolio

SmartDoc (Document) DC Document  Program 

SmartEdit SE Change  Program
Or

Change  Program with Options

SmartTest ST Test  Module/Transaction
ix
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Examples
Example 1. Figure 2 shows the Encore Primary screen that displays when you access 
Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View, 
Extract, Generate, Search, List, Options, and Help.

Figure 2 • Encore Primary Screen

Figure 3 shows the Encore Primary screen that displays when you access Encore through 
ESW by selecting Re-engineer  Program from the ESW action bar menu. Notice that the 
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter 
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 • ESW Encore Primary Screen
x



Preface
Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you 
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays 
when you access SmartTest through ESW. 

Notice that the Analyze features field in Figure 5 lists additional ESW products than 
shown on Figure 4. This field is automatically customized to contain the ESW products 
you have installed on your system. 

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc 
Options) is available on the File - Analyze Submit screen if the SmartDoc product is 
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 •  File - Analyze Submit Screen

Figure 5 • File - Analyze Submit Screen (Accessed through ESW) 
xi
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Publication Conventions
ASG uses these conventions in technical publications:

Convention Represents
ALL CAPITALS Directory, path, file, dataset, member, database, 

program, command, and parameter names.
Initial Capitals on Each Word Window, field, field group, check box, button, panel (or 

screen), option names, and names of keys. A plus sign 
(+) is inserted for key combinations (e.g., Alt+Tab). 

lowercase italic 
monospace

Information that you provide according to your 
particular situation. For example, you would replace 
filename with the actual name of the file.

Monospace Characters you must type exactly as they are shown. 
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.
Vertical Separator Bar ( | ) 
with underline

Options available with the default value underlined (e.g., 
Y|N).
xii



1
 1Introduction
This chapter gives an overview of Estimate, its operating system and the systems it 
supports, and contains these sections:

ASG Service Pack
Verify whether you received an ASG Service Pack for this product. If so, read the 
instructions for installing the Service Pack before proceeding with the product 
installation. The installation instructions are located in the text file on the distribution 
media included with the Service Pack. If you have any problems with the Service Pack, 
contact the ASG Service Desk.

Introduction
Estimate allows organizations to define their Enterprise in terms of business groups and 
applications in order to estimate the time and cost of making large scale application 
changes.

Section Page

ASG Service Pack 1

Introduction 1

Operating Environment 2

Program Language Support 3

Preprocessor Support 3

Alternate Language Support 4
1



 ASG-Estimate Installation Guide
Using a systematic approach, Estimate guides you through these key tasks:

• Defining an Enterprise.

• Locating data items that may be impacted by an application change.

• Locating points of impact for the selected data items and selectively summarize 
them for single Applications, Business Groups, and the Enterprise.

• Generating and reviewing impact reports.

• Reviewing and editing cost factors used to prepare cost reports.

• Generating and reviewing cost reports for Applications, Business Groups, and the 
Enterprise.

The information generated by these tasks can be used to plan the time and resources 
necessary to complete the project.

Estimate uses ESW’s proprietary Analytical Engine and AKR technology, provided by 
Center, to analyze and store detailed application definitions. Estimate’s use of Center, 
which is also the Common Platform for all ESW products, makes it possible to share 
application definitions created with other ESW products, such as Recap and Alliance. 

Operating Environment

Note:
Center installation and customization must be performed before installing Estimate. If 
Center has not been installed, see the ASG-Center Installation Guide at this time.

Estimate has these mainframe environment requirements:

Platform Software/Hardware

Host • MVS/XA, MVS/ESA, or OS/390.

• VSAM or sequential file for the ESW AKR.

• Storage above the 16MB line is used for load modules and 
GETMAINs.

• Direct Access storage. (See the ASG-Center Installation 
Guide for quantities). Storage requirements are listed in the 
ASG-Center Installation Guide.

• 3270 type terminals; Models 2, 3, 4, or 5.
2



1   Introduction
Program Language Support
Estimate supports these versions of COBOL:

Estimate supports these other languages:

• High-Level Assembler through a.3.0

• OS PL/I Version 2

• PL/I for MVS & VM

Preprocessor Support
Estimate supports these preprocessor languages directly:

Note:
Other preprocessed languages are not recognized, but can be supported from the 
generated COBOL code.

Language Version

COBOL • ANSI COBOL

• CASE generated COBOL

• COBOL for MVS and VM

• COBOL for OS/390 (excluding object oriented 
components)

• COBOL/370

• COBOL II (including release 3 and 4)

Product Language

Preprocessor • Command-Level CICS

• Command-Level DL/I

• IDMS

• SQL
3
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Alternate Language Support
Estimate supports these alternate languages:

• Easytrieve

• FORTRAN

• IDEAL

Note:
This option has been discontinued and is only provided for customers currently on 
maintenance.
4



2
 2Estimate Customization
This chapter discusses some of the customization options available in Estimate and 
contains these sections:

Prerequisite
Center installation and customization must be performed before installation and 
customizing Estimate. 

Note:
If you want Estimate support for Endevor-based applications at your site, you must install 
Endevor support. See the ASG-Center Installation Guide for installation and 
customization instructions.

If Center has not been installed, see the ASG-Center Installation Guide at this time.

Section Page

Prerequisite 5

Step 1 - Modifying CNTL Library Members 6

Step 2 - (Optional) Copy Language Criteria Files 7

Step 3 - Customizing Panvalet, Librarian or User Source Managers 9

Step 4 - Invoking Estimate 11

Step 5 - Validating Estimate 12
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Step 1 - Modifying CNTL Library Members
To override Estimate default installation options, modify or add the appropriate 
installation options in VIA$PRMJ (the Estimate installation options member).

Note:
See the ASG-Center Installation Guide Installation Options Appendix for information 
about changing default values of the installation options. 

This is an example of an Estimate specific installation option:

Disable-Foreground-Execution=YES | NO

This specific installation option specifies whether the foreground Job submission is 
disabled through Estimate. Because the foreground execution is considerably more 
expensive in TSO resource usage than batch, it may be important to use batch. If 
foreground Job execution is disabled, then the generation of candidate lists and 
components can only be completed in batch. The default is NO (foreground Job 
submission is disabled).

Alternate Language Support
For alternate language support, uncomment the appropriate lines in VIAJLMNT and edit 
VIA$PRMJ. 

This is the Default-language-criteria option in VIA$PRMJ: 

Default-language-criteria=(<base>,<name>,<displayid>, 
<search1>,<generic lang>,<text>,...)

where: 

base is specified if the language is supported natively, altn is specified for all 
other languages.

name specifies the exact language name string included in the installation option 
Alternate-Lang-Def.

displayid specifies the three letters to be used for the language on displays and 
reports.

search1 specifies the default search criteria member name that contains the 
seeding search criteria for impact due to date conversion for the language. The 
member name must be in the library indicated in the ESW-Hi-Level-Nodes 
installation option.
6



2   Estimate Customization
generic lang specifies the generic name to be used when there are multiple 
language versions. For example, Natural 1.2 and Natural 2.1 should be specified as 
Natural.

text specifies the descriptive text to be used for this language in displays and 
reports.

VIA$PRMJ example:
Default-language-criteria=(BASE,
ASM--MVS,ASM,VIAJASM,MVS-ASSEMBLER,
‘MVS ASSEMBLER Language Versions’,
BASE,COB--MVS,COB,VIAJSCOB,MVS-COBOL,
‘MVS COBOL Language Versions’,
ALTN,NAT1.2,NAT,VIAJSNAT,NATURAL,
‘NATURAL Language Versions’,
ALTN,NAT2.1S,NAT,VIAJSNAT,NATURAL,
‘NATURAL Language Versions’)

Note:
After editing VIA$PRMJ, ensure that the language maintenance time factor in 
VIAJLMNT is uncommented for each language specified in VIA$PRMJ and 
VIA$PRMS. 

See the ASG-Center Installation Guide for additional information about alternate 
language support. You must coordinate the instructions above with the instructions in the 
ASG-Center Installation Guide.

Step 2 - (Optional) Copy Language Criteria Files

Note:
Proceed to step 3 on page 9 if you want the default Search criteria files in English. 

1 Copy the desired national language criteria file to the default language criteria file 
for each of the supported programming languages (COBOL, PL/I, and ASM). The 
language criteria files are stored in the ASG.CENTER.CNTL dataset. 
7
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This table indicates which language criteria files are associated with each language for 
date conversion criteria.

2 Based on the selected language, copy the criteria files to the Impact Project as these 
members:

Associated Search Criteria Members

National Language COBOL PL/I ASM Criteria Type

US - English VIAJS101 VIAJS102 VIAJS103 Date Conversion

FN - French VIAJS201 VIAJS202 VIAJS203 Date Conversion

DU - Dutch VIAJS301 VIAJS302 VIAJS303 Date Conversion

GE - German VIAJS401 VIAJS402 VIAJS403 Date Conversion

IT - Italian VIAJS501 VIAJS502 VIAJS503 Date Conversion

JP - Japanese VIAJS601 VIAJS602 VIAJS603 Date Conversion

SP - Spanish VIAJS701 VIAJS702 VIAJS703 Date Conversion

Language Date Conversion Criteria Files

COBOL ASG.CENTER.CNTL(VIAJSCOB)

PL/I ASG.CENTER.CNTL(VIAJSPLI)

ASM ASG.CENTER.CNTL(VIAJSASM)
8



2   Estimate Customization
3 These are the naming convention definitions for search criteria members in the 
CNTL dataset:

Prefix (5):VIAJS(constant) for date conversion criteria

NatlLang(1): 1 = English
2 = French
3 = Dutch
4 = German
5 = Italian
6 = Japanese
7 = Spanish
8 through 9, A through Z (a one-digit code to 
accommodate up to 35 national languages)

ProgLang(2) 01 = COBOL
02 = PL/I
03 = ASM

Step 3 - Customizing Panvalet, Librarian or User Source 
Managers

Panvalet Customization

To customize Panvalet

Note:
Do not perform step 1 if you are using Panvalet R12 and the module PAM is available in 
LINKLST or LPA.

1 Edit CNTL member VIASPAMJ and specify a valid JOB card and the correct values 
for these parameters:

• VIASOFT

• CENTER

• ASMBLR

• PANLIB

• SYSOUT

• SYSDA

2 Submit this job to assemble and link edit the Panvalet VIASPAM module.
9



 ASG-Estimate Installation Guide
If Panvalet requires changes to its customized edit panel, these changes may need to be 
included in the ESW panels VSPENPAN, VSPE2PAN, and VSPEDPAN. If this situation 
occurs, contact the ASG Service Desk for instructions.

If the Panvalet load library is allocated under ISPLLIB and the LIBDEF facility is used, 
WTP MEMBER NOT FOUND warning messages display each time you select a Panvalet 
member. Try these alternatives to correct the problem:

• Add Estimate allocations to LOGON and bypassing LIBDEF processing.

• Adding the Panvalet load library allocation to VIALLIB in LIBDEF processing.

• Setting WTPMSG OFF (not recommended).

Librarian Customization

To customize Librarian

1 Edit CNTL member VIASFAIJ and specify a valid JOB card and the correct values 
for these parameters:

• VIASOFT

• ASMBLR

• CENTER

• LIBRLIB

• LIBRMAC

• SYSOUT

• SYSDA

If you are running on Librarian R3.9, edit CNTL member VIASFAIR and comment 
out the four lines containing these delete statements:

DELETE EPLOC=XFAIROPN
DELETE EPLOC=XFAIRMOD
DELETE EPLOC=XFAIRREC
DELETE EPLOC=XFAIRCLS

2 Submit this job to assemble and link edit the Librarian VIASFAIR module.

 If Librarian requires changes to its customized edit panel, these changes may need to be 
included in the ESW panels VSPENLIB, VSPEDLIB, and VSPE2LIB. If this situation 
occurs, contact the ASG Service Desk for instructions.
10
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If the Librarian load library is allocated under ISPLLIB and the LIBDEF facility is not 
used, WTP MEMBER NOT FOUND warning messages display each time you select a 
Librarian member. Try these alternatives to correct the problem:

• Add Estimate allocations to LOGON and bypassing LIBDEF processing.

• Add the Librarian load library allocation to VIALLIB in LIBDEFF processing.

• Set WTPMSG OFF (not recommended).

Other Source Managers
Use these instructions to support other user or vendor developed source managers: 

• VIAEDUSR - Modify the distributed CLIST VIAEDUSR according to instructions 
in the CLIST. VIAEDUSR is invoked when the User Source manager option is 
selected from the Modify Library pop-up. Panels that may need customization are 
VSPEDUSR, VSPE2USR, and VSPENUSR.

• Edit Options - Make changes to the Options - COPY/Include Libraries screen 
(VEPEOPTS) to reflect the alternate source manager and data set or member names 
used.

Step 4 - Invoking Estimate 

To invoke Estimate from an ISPF Panel

Use these panel definition cards to add an Estimate option to the ISPF Primary Menu or 
another dialog menu. This line can be used to describe the Estimate option to the user:

% S +Estimate - ASG Estimate Tool

This line can be used to invoke Estimate based on the user selection of the letter S:

S, 'CMD(%Estimate) NEWAPPL(VIAJ)'

Note:
After updating the ISPF environment, it may be necessary to re-enter ISPF before the 
Estimate facilities are available.

To invoke Estimate with a CLIST

To invoke Estimate with a CLIST, type TSO VIATM on the command line in the ESW 
primary panel. The VIATM CLIST invokes the ESTIMATE CLIST while specifying the 
NEWAPPL(VIAJ) parameter to set the correct application ID.
11



 ASG-Estimate Installation Guide
Step 5 - Validating Estimate
To verify successful completion of the Estimate installation, perform these functions. Use 
the installation checklist form in Appendix, "Installation Checklist," on page 27 to help 
you with the installation and validation.

Note:
The dataset names used in these validation steps are the default installation names. If you 
have changed any names, use the new names where default names are specified.

To verify successful completion of the Estimate installation

1 To validate the logon library allocations, select the correct menu option to invoke 
Estimate.

Note:
If you installed Estimate as indicated in "Step 3 - Customizing Panvalet, Librarian 
or User Source Managers" on page 9, use the appropriate selection from the ISPF 
menu.

2 Select Help  About from the Help pull-down to verify that the correct product 
releases and levels of Estimate and Center have been installed. The name, release 
number, maintenance level, and operating system appears on the Help - About 
pop-up.

Press PF3/15 to return to the Estimate primary screen.

3 Review or modify the Estimate product options by performing these steps:

a Select Options  Product parameters from the Options pull-down to display the 
Options - Product Parameters pop-up.

b Review or modify the parameter definitions and press PF3/15 to exit.

c Select Options  Process log/list file from the Options pull-down to display the
Options - Log/List Definition pop-up.

d Review or modify the Log file defaults. Enter valid JOB statement information 
and press PF3/15 to exit.

e Select Options  PF keys from the Options pull-down to display the 
Options - PF Key Definition pop-up.

f Review or modify the PF key definitions. Press PF3/15 to exit.
12
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4 To allocate an AKR, select File  AKR utility from the File pull-down to display the 
File - AKR Utility pop-up.

Note:
If you created an AKR when validating another ESW product, proceed to step 5 on 
page 14.

a Complete the File - AKR Utility pop-up by entering the name of a AKR to be 
allocated. Type A in the command input area and press Enter.

Note:
The fields on the File - AKR Allocate/Expand pop-up vary depending on the values 
for AKR-DSORG-VSAM and SMS in the Center installation options file.

b The AKR name displays on the File - AKR Allocate/Expand pop-up. Verify 
that it is correct and perform these actions:

— Enter the Management, Storage, and Data classes to be used for the AKR 
or enter the value for Volume, Space Units, and Amount.

— Enter the appropriate unique parameter if you are allocating a VSAM 
AKR.

— Enter Job statement information for your site.

— If this dataset must be cataloged in a private catalog, enter C in the 
command input area to display the AKR Catalog Information pop-up. 
Enter the user catalog name and password as required and then press 
PF3/15 to return to the File - AKR Allocate/Expand pop-up.

— Submit the job by entering S in the command input area.

— Wait for the job to finish and verify that the AKR is successfully allocated 
and initialized.

— Press PF3/15 (END) repeatedly until you reach the Estimate primary 
screen.
13
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5 Once an AKR is allocated, the AKR allocate utility has been validated. Figure 1 
shows the File - AKR Allocate/Expand pop-up using SMS and a VSAM AKR.

The customization and validation of Estimate is now complete.

Figure 1 • File - AKR Allocate/Expand Pop-up with SMS and a VSAM AKR
14



Appendix A

Installation Checklist
Company: _________________________________________________

Installer: _________________________________________________

Date: _________ / _________ / _________

AKR Utility Test

OK PENDING Using the AKR Utilities pop-up:

____ ____ Allocate a new temporary AKR.

____ ____ Expand the new temporary AKR using the Expand 
Existing AKR Y|N option on the File AKR 
Allocation/Expand pop-up.

____ ____ Delete the temporary AKR by typing TSO DELETE 
'temporary.akr.dsn' on the command line.
27



ASG-Estimate Installation Guide
Product Test

Note:
Testing Estimate consists of loading variations of COBOL, PL/I, and Assembler 
programs that reside in various source managers and that use various COPY/INCLUDE 
libraries. For detailed instructions about performing these steps, see the ASG-Estimate 
User’s Guide.

OK PENDING

____ ____ Define an Enterprise containing a few applications. In 
the application definition, include programs from 
different source libraries that use different 
COPY/INCLUDE libraries. Include programs with a 
variety of compile parameters and a mixture of COBOL, 
PL/I, and Assembler, depending on the languages used 
in your installation.

____ ____ Analyze the applications.

____ ____ Generate the Definition (DEF) Report.

____ ____ Create an Impact Project on the Enterprise.

____ ____ Select one of the applications and Generate a Candidate 
Dataname List in either foreground or batch mode. If 
you generate the list in batch, wait for the job to 
complete before continuing the checklist.

____ ____ Generate the Candidate Dataname List (CAN) Report 
for the selected application.

____ ____ From the Impact View, select TaskManager  Impact 
Process from the TaskManager pull-down. Use the 
GoTo action to initiate one or more of the tasks listed on 
the Impact Process screen.
28
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Log File Test

The installation and validation of Estimate is now complete.

OK PENDING

____ ____ Enter the KEYS command to verify the default PF key 
assignments.

____ ____ Test the log file allocation by Entering the DEBUG 
LOG primary command to force the log file allocation. 
Follow that command with the PRODLVL command to 
force output to the log file.

____ ____ Test the log file job submission facility by selecting 
Options  Process log/list file from the Options 
pull-down. On the Options - Log/List Definition 
pop-up, select the option to release the log file to print.

____ ____ Edit and submit the VIASAKRX JCL to test the AKR 
expansion job. Verify that the VIASAKRX job ran 
successfully.
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Appendix B

Estimate CNTL and CLIST Members
Estimate CNTL Members 

Member Description

VIA$PRMJ Estimate installation options member.

VIA$RLSJ A back-up copy of the Estimate options member used to restore the 
original installation options. It is not referenced by Estimate.

VIAJBCF Base cost factors default values member.

VIAJCPU CPU factors default values member.

VIAJCMNT Component maintenance time factors default member.

VIAJLMNT Language maintenance time factors default member.

VIAJPCA Program classification formula default member.

VIAJPCF Program classification default values member.

VIAJPER Person time estimates default values member.

VIAJSASM Default search criteria member for Assembler language.

VIAJSCOB Default search criteria member for COBOL language.

VIAJSNAT Default search criteria for NATURAL languages

VIAJSOTH Default search criteria for Alternate languages.

VIAJSPLI Default search criteria member for PL/I language.

VIAJS101 National language default search criteria member for COBOL 
language. (English)

VIAJS102 National language default date conversion search criteria member for 
PL/I language. (English)
31



ASG-Estimate Installation Guide
VIAJS103 National language default date conversion search criteria member for 
Assembler language. (English)

VIAJS201 National language date conversion search criteria member for COBOL 
language. (French)

VIAJS202 National language date conversion search criteria member for PL/I 
language. (French)

VIAJS203 National language date conversion search criteria member for 
Assembler language. (French)

VIAJS301 National language date conversion search criteria member for COBOL 
language. (Dutch)

VIAJS302 National language date conversion search criteria member for PL/I 
language. (Dutch)

VIAJS303 National language date conversion search criteria member for 
Assembler language. (Dutch)

VIAJS401 National language date conversion date conversion search criteria 
member for COBOL language. (German)

VIAJS402 National language date conversion search criteria member for PL/I 
language. (German)

VIAJS403 National language date conversion search criteria member for 
Assembler language. (German)

VIAJS501 National language date conversion search criteria member for COBOL 
language. (Italian)

VIAJS502 National language date conversion search criteria member for PL/I 
language. (Italian)

VIAJS503 National language date conversion search criteria member for 
Assembler language. (Italian)

VIAJS601 National language date conversion search criteria member for COBOL 
language. (Japanese)

VIAJS602 National language date conversion search criteria member for PL/I 
language. (Japanese)

VIAJS603 National language date conversion search criteria member for 
Assembler language. (Japanese)

VIAJS701 National language date conversion search criteria member for COBOL 
language. (Spanish)

Member Description
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Estimate CLIST Members 

VIAJS702 National language date conversion search criteria member for PL/I 
language. (Spanish)

VIAJS703 National language date conversion search criteria member for 
Assembler language. (Spanish)

Member Description

ESTIMATE Used to invoke the Estimate product from native TSO.

VIATM Invokes the Estimate program from a CLIST using the application ID 
VIAJ.

Member Description
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